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1.  Intro
'DFE' stands for 'Digital Front End', the application that manages, feeds and monitors a Digital Press.

Two types of DFE's are supported: The Esko DFE and the HP Production Pro.

Automation Engine typically sends print-ready layouts to a DFE, including layouts with Variable Data
(VDP).

Once you have created a Device for such a digital press in the Pilot's Device view, you can start using
the "Submit to ..." tasks.
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2 Automation Engine

2.  Devices (Digital Presses)

Attention:  Before 16.1, Automation Engine already offered the Print on Digital Press task to
print to a digital press. That task has similar functionality but does not use the Devices view.
The type of press and version of the DFE decide if that task or any of the "Submit to …" tasks
can be used..

Tip:  The Devices view can also be opened as a Tool: Go to Tools >  Devices to monitor and
manage your devices in a separate window.

Adding a Digital Press Device

Follow these steps to add a Digital Press device:

1. In Devices view, click on .
2. Select the type of DFE the press is using: Esko DFE or HP Production Pro.
3. Enter the name of the Server computer that this DFE is installed on and click Continue.
4. A list appears with one or multiple DFE's. Select the one you want and click Add.

The status box of the newly created device appears.

Information and Functionality
 

 

The device status box shows following information that it receives from that DFE:

• The name of the device. By default this is the name of the computer where the DFE was detected.

• A device status icon.

In below info on status, the term DFE is valid for both the Esko DFE as the HP Production Pro:

• : The press is idle. The DFE is online, but the press is not producing (not printing).

• : The DFE is online but the press is stopped or down.

• : Retrieving the status of the DFE.
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• : The DFE is oine. The device's computer is shut down or there is a network issue
preventing a connection to the DFE.

• : The press is producing (printing).

• : The press is paused.

Right-click a status box to choose one of these options:

• New Device.... An alternative to clicking .

• Delete (or press ). You will be asked to confirm.

• Rename.

• Info (or press ). This dialog shows details about the device (version, settings, etc.). You can add a
Description to help identify this device. Click Advanced Options for a detailed technical list of its
parameters.
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3.  Tasks related to Digital Printing

3.1.  Convert Colors for Digital Printing (Classic)

You can use this task to convert PDF files’ colors before sending them to your digital press.

It takes both PDF and Normalized PDF files as input. When working with regular PDFs, it will
automatically normalize them using the Normalize ticket that is selected in the Configure tool's
Processing Preferences.

This task keeps your file's metadata intact (for example CAD information).

Tip:  We recommend you place this task towards the end of your workflow, as close to the
output device as possible.

Important:

Make sure your Automation Engine server and your Digital Front End server are using the same
color database (by default, they are each installed with their own color database).

This is needed to make sure you can use the same color strategy for converting your colors in
Automation Engine and for printing your job in the DFE.

See Using Shared Resources between Automation Engine and the DFE for more information.

Use Case
You would typically use this task as follows:

1. Set up a digital printing color strategy in your Color Engine Pilot application (or ask your color expert
to do this for you).

If desired, you can tweak that color strategy until it converts your spot colors exactly as you want it
to (for example, you can add conversion exceptions for specific spot colors).

For more information about setting up a color strategy, see the Color Engine Pilot documentation
that came with your Digital Front End software.

2. Then use your color strategy in this task to automate the conversion of all your file's variants or
"SKUs" (Stock Keeping Units), for example for different languages, sizes, flavors...

Parameters
1. Select the Color Strategy you want to use for the conversion. This must be a digital printing

color strategy created in the Color Engine Pilot application that came with your Digital Front End
software.

Typically, your color strategy doesn't only contain general color conversion settings, but also color
conversion exceptions, either for the spot colors you use the most, or for a whole Pantone book
(see the Color Engine Pilot documentation that came with your Digital Front End software for more
information about color strategy settings).
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3Automation Engine

These exceptions determine the exact percentages of the available output inks that will be used to
print the corresponding spot colors. These have often been adjusted by your color expert to give
you the spot color simulation you want.

2. In Undefined Spot Colors, choose what to do when the file contains a spot color for which your
color strategy has no exception.

• Select Do not convert (keep in output) if you want to leave the spot color untouched in the
output file. Do this for example if you are using certain spot colors as extra output inks (typically
white or metallic inks).

In this case, the task will end in a warning.

Tip:  Consider setting up your workflow so that:

• the output file gets sent to the next task automatically (if you are sure that those spot
colors are extra output inks),

• further processing of the output file is paused, so that you can check whether those
spot colors are actually extra output inks.

• Select Convert to convert that spot color to the color strategy's output profile using the
strategy's general color conversion settings.

• Select Generate error if you don't want to convert the file at all, and instead have the task end in
error.

Do this if you always make an exception for each spot color, so in this situation you want to stop
the workflow and investigate why this is not the case. You may want to either replace the spot
color in your file, or add an exception for that spot color in the color strategy.

3. Select Flatten document if you are experiencing unexpected color results when converting files
containing overprints, transparencies or vignettes.

Flattening your file resolves its overprints and transparencies, and converts its vignettes to images.

In the example below, the original file contains three objects:

• the background (sky),
• the lighthouse, which is knocking out on the background object,
• the wave, which is overprinting on both the lighthouse object and the background object.

 

 

Flattening your file replaces the parts of objects that were overprinting or transparent by other
objects. Those new objects have the color that was resulting from the overprint/transparency, but
are not overprinting or transparent.
 

7



3 Automation Engine

 

Attention:  We recommend that you:

• flatten files with overprints, transparencies or vignettes,
• don't flatten files that you still need to trap or edit afterwards.

If you need to both flatten and trap your file, make sure to do your trapping first, and place
the Convert Colors for Digital Printing task towards the end of your workflow, as close to
the output device as possible.

3.2.  Preflight Color for Digital Printing (Ink based)

Concept
You can use this task to decide which ink set to use when sending a print job to your HP Indigo digital
press.

Some print jobs can be printed just as well with less inks, so reducing the press's number of clicks and
needed print time. However it is often cumbersome and time consuming to check this manually for
every print job.

This task automates the checking and comparison process: it calculates the color accuracy you can
achieve with the ink set(s) you plan to use, and so helps you choose a cost-effective solution that still
meets your quality standards.

Important:  This name of this task mentions "(Ink based)" because it checks the inks that
are used in the input PDF file and then generates a table with information how they can be
converted via selected strategy. This task does not check how or where these inks are used in
this PDF file.

The related task Preflight Color for Digital Printing (Content based) has a different approach: it
scans the PDF's actual data and can so give better info on how this particular file can be printed
on digital press, all based on the selected strategy. This approach generates less numbers but
they may be more relevant. This content based is the one used in ArtPro+, where it is named
'Digital Print Simulation'.

Checking the Color Accuracy Achievable with a Certain Ink Set
If you want to check whether a certain file can be printed with a certain ink set and give a color
accurate result:

1. Choose a color strategy made for printing with that ink set.
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2. Set your color deviation tolerance (above which Delta E value you would consider the print not color
accurate enough).

3. Send your file through the task.
4. The task outputs a detailed report: for each ink in your file needing conversion to your ink set, you

can see the percentages of the inks on press that would be used, and whether the color accuracy
would meet your tolerance.

Any ink that cannot be printed within your tolerance is given a "fail" status.

Your file only has an overall "pass" status if all its inks have a "pass" status. This means that you can
print it color accurately with that ink set.

See Task Parameters on page 9 for more information about setting up your task.

Comparing the Color Accuracy Achievable with Different Ink Sets
You would typically run your file through several Preflight Color for Digital Printing tasks in a workflow:
one task for each color strategy/ink set that you want to check.

Each task then outputs a report detailing the color accuracy you can achieve with that color strategy/
ink set, and gives an overall "pass" or "fail" status for printing your file with that ink set.

This helps you can choose the smallest ink set that gives you a good color match for that file, so that
you can combine quality and cost-eciency.

Note:  The detailed information in the reports helps you take an informed decision in dicult
cases. The final decision always rests with you.

You can use this task:

• on the production floor, to help you maximize the speed and cost-eciency of your digital press
while still printing your jobs with good color accuracy.

See Preflight Color for Production on page 14.

• if you have a sales oce, you can use it to help you quote a competitive price to your customers
without skimping on quality (you can then pass on the ink set information to your prepress/printing
department, saving them the time it would have taken them to check different ink sets).

If your sales oce uses an MIS system, you can even integrate a Preflight Color for Digital Printing
workflow with your MIS system.

See Preflight Color for Cost Estimation on page 16.

3.2.1.  Task Parameters

Set up each task's parameters as follows:

1. Decide which ink set you want to check your file against, and select a Color Strategy whose output
profile uses this ink set.

Depending on whether you want to decide on an ink set for production or for cost estimation, the
exact color strategy you choose may be different.

See Preflight Color for Production on page 14 and Preflight Color for Cost Estimation on page 16.
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Attention:

• You can only select a digital printing color strategy. If you select another type of color
strategy (through a SmartName for example), the task will end in error.

You can create digital printing color strategies in Color Pilot (or in any older Color Engine
Pilot 13.X version that came with your Digital Front End software).

See the Color Pilot documentation (or the Color Engine Pilot documentation that came
with your Digital Front End software) for details.

• Make sure your Automation Engine Server and your Digital Front End server are using
the same color database (by default, they are each installed with their own color
database).

This is especially important for production, as you want to check your file against the
exact color strategies you can use in the DFE to print it.

See Using Shared Resources between Automation Engine and the DFE for more
information.

• The task will also end in error if it cannot find your chosen color strategy in the color
database (if for example it was deleted before you ran the workflow).

2. Select the Delta E Formula to use to calculate the color difference between the spot colors in your
file and how they can be reproduced using your chosen Color Strategy.

You can choose from:

CIELAB Delta E,
Delta E 94,
Delta E 2000,
CMC (1:1),
CMC (2:1),
Delta E 2000 (2:1:1).

Note:  If your company is already using one of those formulas, we recommend that you
choose the same one. If not, you should choose Delta E 2000, which is the best reflection of
the visual difference between colors.

3. Choose how close (in Delta E) the output colors must be to the colors in your input file for you to
accept the print job as color accurate, and enter this number in Delta E Tolerance for Spot Colors.

The default tolerance is 2 Delta E, as color deviations under this threshold are generally not visible
to the human eye.

3.2.2.  Preflighting a File's Colors

You can send either PDF or Normalized PDFs files through this task. When working with regular PDFs,
it will automatically normalize them using the Normalize ticket that is selected in the Configure tool's
Processing Preferences.

When running a file through this task:
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1. The task calculates how to convert the file's separations to your chosen Color Strategy's output
profile.

It checks all separations except:

separations that should be output as they
are

• process separations
• other separations used in the output profile (when

checking against a multicolor profile)
• separations set to "Keep in Output" in the color

strategy (for example White or metallics)

separations that never require color
management

• technical separations
• varnish separations
• separations set to "Do Not Print" in the color

strategy

certain separations that have predefined
conversion values set in the color strategy

separations converted through a conversion table

Note:  Other separations with conversion
exception values in the color strategy
(refined conversion values obtained with
measurements or custom conversion values
added manually) are checked.

For more information about separation conversions
values in color strategies, see the Color Pilot
documentation.

2. For each separation, it checks whether the color difference between the converted color and the
original color is within the Delta E Tolerance you have specified, and gives a pass or fail status.

3. It writes all of the pass or fail statuses for that file into an XML report, and gives an overall pass
or fail status for that color strategy (pass means that the color difference is within your Delta E
tolerance for all separations, but if at least one separation has a higher Delta E then the overall
status is fail).

You can see the preflight results in the Log Info or the XML report. See Color Preflight Results on
page 12 for more information.

4. When running your file through several Preflight Color for Digital Printing tasks in a workflow, you
can see which color strategies give a pass, and choose to use the smallest ink set that still gives
you a good color reproduction.
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Note:

• To see more details on the color reproduction of each color strategy, you can either
check their XML reports manually or feed them to your MIS system.

• The final decision on what color strategy to use always rests with you.

If for example one of the color strategies gives you good Delta Es for all separations but
one, and that separation is only present in a very small and less important area of your
file, you can still decide to use that color strategy anyway.

If none of the ink sets/color strategies gives a good color reproduction, you may want to
(depending on the case) use one or more additional spot colors, print the file with one of
the color strategies anyway, tweak the color strategy in Color Pilot, adjust the file...

For more information about using several Preflight Color for Digital Printing tasks in a workflow, see:

• Preflight Color for Cost Estimation on page 16
• Preflight Color for Production on page 14

Color Preflight Results

Processing Status
• After running the Preflight Color for Digital Printing task on your input file, the Tasks pane shows

the processing status (and not the preflight status).

Task status Processing status

 Successfully done Input file processed successfully (whether the Delta E values for
the ink conversions are within your required tolerance or not)

 Done with warning Input file contains unregistered inks (inks that are not part of an
ink book in your color database)

 Failed The color strategy is invalid or doesn't exist

To see the preflight status (and detailed results), you should open the task's Log Info, or the XML
report it produced.

• When running the task in a workflow, the XML report is sent through a different output pin
depending on both the processing status and the preflight status.

There are 5 output pins, corresponding to the following statuses:

Output pin Processing status Preflight status

 Pass Input file processed successfully With this color strategy, all
conversions are within your Delta E
tolerance

 Fail Input file processed successfully With this color strategy, at least one
of the conversions gives a Delta E
above your tolerance
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Output pin Processing status Preflight status

 Pass Unregistered Input file contains unregistered inks All conversions are within your Delta
E tolerance

 Fail Unregistered Input file contains unregistered inks At least one of the conversions gives
a Delta E above your tolerance

 Error The color strategy is invalid or
doesn't exist

Cannot preflight

Preflight Results Details in the Log
You can see the preflight results in detail in the task's Log Info.

 

 

Under Results, it lists:

• which of the input file inks were converted by your chosen color strategy (certain ink types are never
converted)

Note:  If your input file contains a double strike of an ink (a percentage above 100%), this ink
will appear twice.

• the conversion values for those inks (in percentages of the printing inks)

• the Delta E achieved for each converted ink
• the overall PASS or FAIL status

Attention:  After running a workflow containing the Preflight Color for Digital Printing task,
make sure you open the task's Log Info and not the workflow's Log Info (as the workflow's log
only contains processing information).
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Preflight Results Details in the XML Report
Each Preflight Color for Digital Printing task also generates an XML report containing detailed results
about the conversion to your chosen color strategy with your desired Delta E tolerance.

 

 

It contains the same information as the log, but is formatted to be easily usable by an MIS system (or
Automation Engine's Join XML Files task, in preparation for sending to an MIS system).

If you are reading this XML report yourself:

• you can find the overall status at the top of the file (for example Status="passed"),

• you can check which of the input inks were converted (ink types that are never converted indicate
the reason in their status, for example Status="IsProcessInk" or Status="IsVarnish"),

• for the inks that were converted, you can see the resulting percentages of the printing inks in
DeviceColor, and the Delta E achieved.

3.2.3.  Preflight Color for Production

You can use the Preflight Color for Digital Printing task on the production floor, to help you maximize
the speed and cost-eciency of your digital press while still printing your jobs with good color
accuracy.

When using this task to prepare for production, you want to decide on the ink set to use for your print
job, but you may also want to take into account any tweaks necessary to get the best color result on
your particular digital press.

This means that for each Preflight Color for Digital Printing task that you run on your file, you should
select a Color Strategy using your digital press profile as an output profile.

Tip:

When profiling your digital press in Color Pilot, you can easily generate:

• a color strategy with your digital press profile as output profile,
• additional color strategies with a subset of that profile's ink set as output profile (for

example, if you profiled your digital press with a CMYKOV ink set, you can also generate
color strategies to output to CMYK, CMYKO and CMYKV on that press).

See the Color Pilot documentation for details.
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Example Workflow
One of the simplest ways to set up a workflow to check what ink set a file can be printed with is to
cascade several Preflight Color for Digital Printing tasks.

 

 

1. This workflow first marks the input file with a tag (File to Preflight) then sends it to the first
Preflight Color for Digital Printing task.

2. This task checks whether printing the file with an EPM (CMY) color strategy would give a good color
accuracy.

Note:

Make sure the color strategies you use in all your Preflight Color for Digital Printing tasks:

• are digital printing color strategies,
• use (one of) your digital press(es)'s profile as output profile.

For information about generating color strategies outputting to several ink sets from a
digital press profile, see the Color Pilot documentation.

The task outputs an XML report detailing the color accuracy that can be achieved.

• If printing the file with EPM would give good results, the report goes through the  Pass output
pin (the first green pin), and the workflow is finished.

• If EPM doesn't give a good color accuracy, the report goes through the  Fail output pin (the
second green pin), and the workflow continues.

• If your file contains one or more unregistered inks (inks that do not exist in your color
database), it goes through one of the orange output pins (either  Pass Unregistered or  Fail
Unregistered depending on the Delta E values).

In this case, the workflow ends with a warning (regardless of the Delta E values, the file isn't
checked by any other Preflight Color for Digital Printing task).
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• If the color strategy you have selected in your first Preflight Color for Digital Printing task
doesn't exist (if for example it was deleted before you ran the workflow) or is not a digital printing
color strategy, the report goes through the red  Error output pin and the workflow ends with an
error.

3. If the first color strategy (EPM) didn't give a good color accuracy, the XML report going through the
second output pin triggers the Select Marked File workflow control.

This is set to select the input PDF/Normalized PDF corresponding to that XML report (using the
File to Preflight tag and Only select when name matches: [File]).

See Mark File and Select Marked File for more information.
4. That input PDF/Normalized PDF is then passed on to the next Preflight Color for Digital Printing

task, that checks whether printing the file with a CMYK color strategy would give a good color
accuracy.

5. If this is not the case, the file is checked against an IndiChrome (CMYKOV) color strategy, then if
necessary an IndiChrome Plus (CMYKOGV) one.

6. If none of the ink sets/color strategies gives a good color reproduction, the workflow ends in a
warning.

You can then check the different XML reports to help you make a decision about how to print your
file.

Depending on the case, you may want to use one or more additional spot colors, print the file with
one of the color strategies anyway, tweak the color strategy in Color Pilot, adjust the file...

3.2.4.  Preflight Color for Cost Estimation

You can use the Preflight Color for Digital Printing task at your sales oce, to help you quote a
competitive price to your customers without skimping on quality.

You can even connect it to your MIS system (for example CERM or Label Traxx), to get the print job
information automatically, then send the color preflight results back to the MIS.

When using this task for cost estimation, the main goal is to decide on the ink set needed to print your
job with a good color accuracy.

At that stage you don't need to worry about tweaking the print job to print on a specific press so you
can use a Color Strategy with a generic output profile (for example ISOcoated_V2_eci.icc for the
CMYK ink set).

Example Workflow
There are many ways you can set up a workflow that checks what ink set a file can be printed with so
you can quote a competitive price to your customers. For example, you can:

• Set up a cascading workflow that checks the file against each ink set, then check the workflow's
results to choose the ink set to use (this is similar to the production workflow, but here you can
use generic color strategies with the right ink sets, instead of color strategies made for a specific
digital press).

• Set up a workflow with one Preflight Color for Digital Printing task, where the color strategy and
Delta E tolerance are public parameters, and enter all the color strategies you want to check as a
semicolon-separated list (for example CMY;CMYK;CMYKO;CMYKOV;CMYKOGV). For each color
strategy you specify, your file will go through the task and you will get an XML report.

• Set up a workflow that integrates with your MIS system, so that you can automatically launch the
workflow on any file that comes into your MIS system for quotation, and get the results back into
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your MIS system (this way you can do this from your sales oce without even needing to open the
Automation Engine Pilot).

Workflow with MIS Integration
This example workflow is set up to:

• take a PDF file,
• check it against a list of color strategies and a specific color tolerance (that are saved as workflow

parameters),

• join all XML reports into one and save it in a location that your MIS system monitors,
• end in OK for the color strategies that can be used to print within the color tolerance, and in

Warning for all other cases.

 

 

1. Preparation

The input file is paired with every color strategy that needs checking, and sent through the
workflow as many times as there are color strategies.

a) The input file is marked with the cp_InputFile tag so it can be picked up by the workflow
later on.

b) The Run Script task generates an XML file for each color strategy, containing the input file name
and color strategy name. Those XML files are marked as cp_tempfile.

c) The Data Splitter sends the XML files one by one to the rest of the workflow, where they will
each trigger a color strategy check.

2. Color Preflight

For each input file/color strategy pair, the Preflight Color for Digital Printing task checks the color
accuracy that can be achieved, and generates a detailed report.

For each XML file sent from the Data Splitter:

a) The Modify Workflow Parameter Values workflow control picks up the color strategy name in
the XML and saves it to the SelectedStrategy workflow parameter.

b) The Select Marked File workflow control picks up the input file and sends it to the Preflight
Color for Digital Printing task.

c) The Preflight Color for Digital Printing task checks whether converting the input file with the
current color strategy (from the SelectedStrategy workflow parameter) would give a Delta E
within the required Delta E tolerance (from the Tolerance workflow parameter).

It outputs an XML report detailing the color accuracy that can be achieved with that color
strategy, through the appropriate output pin.
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d) If the file can be printed within the color tolerance using that color strategy, the State workflow
parameter is set to Pass. Otherwise it is not changed.

3. Reporting

The Data Collector collects all XML reports and sends them to the Join XML Files task, to make a
single big XML file for easy consumption by the MIS system. This file is saved in a location that the
MIS monitors.

4. Cleanup

The individual XML reports are marked as cp_tempfile and, together with the other temporary
files (the XML files produced by the Run Script task), they are deleted.

5. Workflow End State

The Router directs each iteration of the input file to the right workflow end state based on the
State workflow parameter set by the Preflight Color for Digital Printing task.

• For color strategies that gave a Delta E within tolerance (the State is Pass), the file goes to OK.

• For color strategies that didn't (the State still has an empty value), it goes to Warning.

The MIS system can then check the end state of the workflow and analyze the joined XML file
containing the color accuracy information for the input file checked with all color strategies.

Note:

Like all Automation Engine workflows, this workflow can be triggered by a JDF file dropped into
a "hot folder"/folder access point for example).

If the JDF contains information about the color strategies to check and the desired Delta E
tolerance, they will overrule those set in the workflow parameters.

At the end of the workflow, the MIS system will get a JDF back, containing processing
information and the location of the joined XML file.

3.2.5.  Pre-configured Preflight Color Workflow

For an easy start with the Preflight Color for Digital Printing task, you can use the pre-configured
workflow made by Esko.

This workflow combines the ink set analysis from the Preflight Color for Digital Printing task with
other Automation Engine capabilities, so that you can automatically:

• perform some PitStop preflight checks on your input file to determine whether your file's objects
are compatible with EPM (CMY) printing (for example check for Rich Black objects, black-only
images, etc.),

• analyze your file's spot colors to determine which ink set(s) you can print it with for a good color
match (CMY, CMYK or CMYKOGV),

• process multiple input files and/or multipage files if needed,
• get both a PDF report with a clear indication of the ink sets you can use, and an XML report for your

MIS or quoting/cost estimation system.

Esko will help you deploy this workflow. Please contact your Esko representative for more information.
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You can also request a custom workflow based on this pre-configured workflow (for your click-based
HP Indigo digital press), if this would fit your needs better.

Note:  This workflow can process most jobs, but is not suitable for jobs containing white
underprint, or jobs with more than 12 spot colors.

Requirements
You need the following as a starting point for deploying the Preflight Color pre-configured workflow:

Software Requirements
Compulsory:

• Automation Engine 18.0 or later with the "Reporting and 3D" and "Processor" modules
• either Color Pilot 16.x or later, or Color Engine Pilot 13.x (included with HP SmartStream Labels &

Packaging Print Server 4.0 or later)

Optional:

• the "Automation Engine Connect" module, if you need to connect to an external system, for example
an MIS system

• the EPM (Enhanced Productivity Mode) option on your HP SmartStream Labels & Packaging Print
Server/HP Indigo digital Press, if you want to use CMY/EPM

Hardware Requirements
Please see the requirements for your version of Automation Engine:

• for Automation Engine 18.0: server and client system requirements

• for Automation Engine 18.1: server and client system requirements

• for Automation Engine 20.0: server and client system requirements

License Requirements
"Automation Engine Check Color Strategy"

Preparation
You need to do some preparation to ensure that your Esko representative configures the workflow
optimally for your needs.

Preparing Your Press Profiles
You need to:

• Make a list of all the HP Indigo digital presses and substrates you use.

• Make sure that for each press/substrate combination that you use, you have an accurate and up-to-
date press profile.

Your press profiles should be made with your full press ink set (CMYKOGV).

Your Esko representative will create CMYKOGV, CMYK and CMY (if you are using it) color strategies
based on your CMYKOGV profiles. These color strategies will be used in the workflow to check which
ink set(s) your jobs can be printed with.
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Note:

You can create digital press profiles in your Color (Engine) Pilot application.

Your color database contains a number of predefined profiles for certain substrates (for
example HPI-CREAM-ANTIQ-CMYKOGV for the Fasson Cream Antique TOP substrate).

You can use these profiles for a faster start-up, but a profile made specifically for your press
will always be more precise.

Outlining Your Way of Working
Prepare the following information (that will be needed to configure your workflow):

• whether you work with EPM/CMY,
• whether you need to connect to an external system (MIS, quoting/cost estimation system...),
• whether you want your PDF reports in a language other than English,
• which ink names you want to exclude from the ink set analysis (technical inks, varnish inks...),
• which Delta E formula and Delta E tolerance you use when assessing color matches.

If you are working with EPM, the workflow includes a set of additional checks to help assess EPM
suitability:

• checking for black-only images or gradients,
• checking whether the job contains only black, or no black,
• checking for Rich Black objects (fill or stroke),
• checking for very small black objects or strokes,
• checking for very small black text,
• checking for areas with high Total Area Coverage.

You will have the opportunity to discuss which of these checks to apply to meet your particular needs
with your Esko representative.

Workflow Overview
There are two variants of the pre-configured Preflight Color workflow:

• the main Preflight Color workflow, that can:

• perform some PitStop preflight checks on your input file to determine whether your file's objects
are compatible with EPM (CMY) printing (for example check for Rich Black objects, black-only
images, etc),

• analyze your file's spot colors to determine which ink set(s) you can print it with for a good color
match (CMY, CMYK or CMYKOGV),

• get both a PDF report with a clear indication of the ink sets you can use, and an XML report for
your MIS or quoting/cost estimation system.

See Main Workflow on page 20.
• the multipage Preflight Color workflow, that can do all of the above, but for multiple input files and/

or multipage files.

See Multi-page Workflow on page 22.

Main Workflow
The main pre-configured Preflight Color workflow variant can:
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• perform some PitStop preflight checks on your input file to determine whether your file's objects
are compatible with EPM (CMY) printing (for example check for Rich Black objects, Total Area
Coverage, etc),

• analyze your file's spot colors to determine which ink set(s) you can print it with for a good color
match (CMY, CMYK or CMYKOGV),

• get both a PDF report with a clear indication of the ink sets you can use, and an XML report for your
MIS or quoting/cost estimation system.

Note:  If you have multi-page files/multiple input files, you should use the multi-page workflow
variant instead.

 

 

1. EPM Preflight Check
 

 

If you are using EPM, the workflow runs EPM preflight checks on your file. Those checks help assess
how suitable EPM is for printing your job.

Your Esko representative will have tailored these checks to your way of working.
2. Technical Inks Removal

 

 

The workflow removes any technical/varnish... inks that don't need to be color converted.
3. Color Analysis
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The workflow analyzes how accurately your job can be printed with CMY (if you are using EPM),
CMYK and CMYKOGV using the substrate and press you chose.

To do this, it converts your job's colors using the color strategies made for your press and substrate.
4. Reporting

 

 

The workflow creates an XML report for your 3rd party system, and a PDF report for you.

The (final) XML report contains the results of the EPM preflight check, as well as the information
from the individual XML reports generated by each Preflight Color for Digital Printing task (for CMY,
CMYK and CMYKOGV).

5. Cleanup
 

 

The workflow cleans up the input files and individual XML reports.

Multi-page Workflow
The multi-page variant of the pre-configured Preflight Color workflow does everything the main
workflow variant does, but can process:

• both single page and multi-page files,
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• both single files and multiple input files.

You should use this workflow variant when working with multi-page files/multiple input files, but when
working with single one-page files, we recommend you use the main workflow (as it is a little faster).

 

 

1. File/Page Splitting

The workflow checks the number of pages of the input file, and splits multi-page files into individual
pages.

Then it feeds those pages (or any single page file that came in) individually to the rest of the
workflow.

2. Preflight and Color Analysis (Main Workflow)

This sub-workflow:

a) runs EPM preflight checks on your file (if you are using EPM),
b) removes any technical/varnish... inks that don't need to be color converted,
c) analyzes how accurately your job can be printed with CMY (if you are using EPM), CMYK and

CMYKOGV using the substrate and press you chose,
d) creates an XML report for your 3rd party system, and a PDF report for you.
See Main Workflow on page 20 for more details.

3. Cleanup

This part of the workflow collects all files, and:

• keeps the reports for you to review (it adds a review task to your To Do list),
• deletes the input files and pages.

Using the Workflow(s)
Like with all Automation Engine workflows, you can run the pre-configured Preflight Color workflow on
your files from the Pilot, Shuttle, or automatically through a connection with an upstream system.

If you are using the Pilot:

1. Select your one-up PDF and launch the pre-configured Preflight Color workflow.
Use the workflow name given by your Esko representative (for example
ColorPreflight_V1_main).
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2. In the ticket that opens, choose the Substrate and Press you want to print your job with, and click
Launch.

3. The workflow automatically:
a) splits the file's pages to analyze them one by one (if you are using a multipage file and the

multipage workflow),
b) runs EPM preflight checks on your file (if you are using EPM),
c) removes any technical/varnish... inks that don't need to be color converted,
d) analyzes how accurately your job can be printed with CMY (if you are using EPM), CMYK and

CMYKOGV using the substrate and press you chose,
e) creates an XML report for your 3rd party system, and a PDF report for you.

4. Based on the report data, you can easily see what ink set(s) give you a good color match, and decide
on the best ink set to use based on cost and quality.
The report also contains more detailed information (about the Delta E values, EPM checks...) if you
need it. See PDF Report on page 24 and XML Report on page 26.

Workflow Reports
When using the pre-configured Preflight Color workflow, you get both:

• a PDF report with a clear indication of the ink sets you can use,
• an XML report for your MIS or quoting/cost estimation system.

PDF Report

The PDF report gives you a clear indication of the ink sets you can use, as well as more in-depth
information to help you make a decision even in dicult cases.
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1. This area contains the job information: input file name, date and time, substrate and press chosen,
and a thumbnail of the job.

2. You can see the ink set(s) that give you a good color match at a glance, with "trac light" indicators.
3. This area lists the input file's inks. Only spot colors are converted (see converted separations for

more information).
4. This shows the result of each EPM check ran by the workflow, and the values used where applicable.
5. On the report's second page, you can see the conversion details for each of your input inks, for

the different ink sets. You can clearly see which conversion option(s) meet your color matching
tolerance.
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Note:  By default, this report is in English, but it can be generated in your language of choice
(ask your Esko representative).

XML Report

If you need to make the color conversion results available to an external system (for example an MIS or
quoting software), use the XML report.

Like the PDF report, the XML report contains both high-level information about which ink set(s) give
you a good color match for a particular job, and more in-depth data about EPM checks and color
conversion.

• When using individual Preflight Color for Digital Printing tasks, you get an individual XML report per
task, detailing whether your job's spot colors can be printed with the ink set chosen in the task (see
Color Preflight Results on page 12).

• When using the pre-configured Preflight Color workflow, you get a single XML report, that
combines:

• the results of the EPM checks the workflow ran on your job,
• the information from the individual XML reports generated for each ink set.
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This combined XML report contains:

1. information about the job,
2. the settings used in the workflow (your color match tolerance, the values used in the EPM checks,

the substrate and press chosen),
3. the spot colors to convert,
4. the results of the EPM checks,
5. a "passed" or "failed" result for each ink set,
6. the spot color conversion details.

3.3.  Preflight Color for Digital Printing (Content based)

Concept
This task checks whether the color data in a file is within range to be printed satisfactory on a digital
press.

Based on a selected color strategy and a maximum Delta E, it scans the input file's graphical data and
concludes if the file survives the selected quality criteria.

This technology is also available on board ArtPro+, as a visual tool (part of the quality control tools). It is
there called 'Digital Print Simulation'.
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Important:  The related task Preflight Color for Digital Print (Ink based) has a different
approach: it only checks the inks that are used in the input PDF file and then generates a table
with information how they can be converted via selected strategy. It does not check how or
where these inks are used in the input file. This (older) approach generates more numbers but
they may be less relevant when printing this particular PDF input file.

Task Settings
• Color Strategy: Select a digital printing color strategy that will be used to judge the color range

when printing this file.

• Delta E Limit: When the file has any area with a Delta E higher than this value, the preflight will
result in 'failed' (i.e. it will be reported as such in the output XML file). The maximum value in this
field is 10.

Note:  Processing Steps are not included in this calculation.

Note:  This task only checks the content of the input file's first page.

Result XML file
This task outputs an XML file that describes the preflight result (the maximum Delta E found in the file
versus the allowed limit). It also mentions the average Delta E and the size of the area in the file (trim
box) that was exceeding that allowed limit (in % and in mm2) .

Some examples:

• This example shows that the preflight failed for this file because the maximum Delta E limit was
much bigger than allowed by the ticket (Tolerance).

<?xml version="1.0" encoding="utf-8" ?>
<StrategyAccuracy Strategy="HPI-EPM-075_Digital" Status="failed">
   <PassFailSettings DeltaEMetric="Delta E 2000" Tolerance="3" />
   <Result MaximumDeltaE="11.68" AverageDeltaE="6.63" PercentageOver="87.80%"
 AreaOver="16198.86" />
</StrategyAccuracy>

• When a file passes this preflight, the XML will mention "passed":

<?xml version="1.0" encoding="utf-8" ?>
<StrategyAccuracy Strategy="HPI-EPM-050_Digital" Status="passed">
   <PassFailSettings DeltaEMetric="Delta E 2000" Tolerance="5" />
   <Result MaximumDeltaE="4.39" AverageDeltaE="2.90" PercentageOver="0.22%"
 AreaOver="69.17" />
</StrategyAccuracy>

3.4.  Print on Digital Press

Attention:  Unlike the "Submit to …" tasks, this task currently still has more elaborated
functionality but does not use the Devices view. The type of press and version of the DFE
decide which type of task can be used.
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Important:  This task can serve 2 kinds of DFEs:

• The HP SmartStream Labels and Packaging Print Server Powered by Esko. In below pages,
for sake of easy reading, we will name this the HP DFE.

• The Esko (Inkjet) DFE, a DFE serving several types of inkjet digital presses.

Note:  To see which version of the DFE engine software supports which version of Automation
Engine's Print on Digital Press task, check http://www.esko.com/systemrequirements.

Working with a DFE (Digital Front End) Server
Automation Engine can use files in its Containers to create Print Jobs on a DFE Server. Automation
Engine monitors those print jobs until they are printed on the digital press.

In Automation Engine:

• use the Print on Digital Press task to create print jobs on the DFE server. This step typically creates
a step & repeat PDF and also executes color management.

• the Print on Digital Press (Track) task is started automatically and shows the status of the print
jobs on that DFE server, also of print jobs that were not created via this task.

Both these tasks show detailed feedback for each step of the DFE printing process in the Pilot's Tasks
pane.

Setup

Before using those tasks, you must connect your Automation Engine server to your DFE server. This is
done in the Configure panel (Digital Press). This task does not connect to devices that you set up in the
Devices view.

Note:  When your DFE server drives several digital presses, you also need to select the press to
connect to.

3.4.1.  Supported File Types

The task can send these file types to a digital press:

Note:  'Static' print jobs are print jobs that are not VDP jobs.

For 'Static' print jobs: For Variable Data Print jobs:

• PDF
• Normalized PDF (self-

contained, so images
embedded)

• PDF/VT (for example generated by Adobe Illustrator, by using the
Dynamic VDP Plug-in).

• VDT (Variable Data Template), also made in Adobe Illustrator, by using
the Dynamic VDP plug-in.
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For 'Static' print jobs: For Variable Data Print jobs:

Note:  This can
be a one-up or an
already stepped
self-contained PDF.

• PDFPLA (Plato PDF)

Note:  Before PDF/VT, the Print on Digital Press (PPML) task
was used to have Automation Engine use PPML files to create
variable print jobs on the DFE server. This task has been declared
'Soon Outdated'. Learn more in Print on Digital Press (PPML) (Soon
Outdated)).

Note:  If your MIS system stores print job parameters in JDF format, you can add that JDF file
to the input of the Print on Digital Press task.

About Variable Data Printing

When using a VDT file to print a VDP job, the expansion of the variable data (using the Variable Data
Database) happens on the DFE. This is typically used when executing the expansion in Adobe Illustrator
or Automation Engine takes too much processing resources.

Note:

• A VDT file contains VDP objects (placeholders for the variable data) and must be expanded
to a PDF/VT file on the DFE server.

• A VDT file can be created with the Dynamic VDP DeskPack plug-in.

• Fonts used inside the VDT file must be installed on the DFE server.

3.4.2.  Using the Print on Digital Press Ticket in a Workflow

Unlike most workflow steps, the Print on Digital Press step does not create output files to be
transferred to the next workflow step, but sends this output data to the DFE server.

This also means that this task step is always the final task in a workflow (branch).

In the workflow editor, you can see the number of files the task has successfully processed on its
output pin called Inputs.
 

 

3.4.3.  Print on Digital Press Task Settings
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Device: Choose the digital press you want to send your file to. This list contains all the digital presses
that you added in Configure.

Print Job Ticket: Choose the print job ticket you have created on the DFE server to process and print
jobs. In the list of tickets, notice the column indicating their Workflow Type: Dynamic or Classic.

Note:  When using the Print on Digital Press task, make sure the DFE server is running and that
the Print Controller on the DFE is running. When your task is stuck, check if the Digital Press
connection is still OK (in the Configure tool).

Note:  For all parameters in the below mentioned settings, you can choose the SmartName
[From Print Job Ticket]. This will use the parameter value as defined in the selected DFE Print
Job Ticket.

The value that the SmartName finds in the chosen Print Job Ticket
is then shown to the right of the input field, between parenthesis. For

example:

If you added a JDF file to the task input, you can choose [From JDF Ticket] to use the
parameter value defined in that JDF file.

We now illustrate the settings in the tab sheets:

General Tab
 

 

• Print Job Name: Keep the name if the input file or use a SmartName, Public Parameter or Workflow
Parameter to define a different one.
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• Substrate: Shows the list of substrates available on the press.
• Copies: Enter the number of copies to be printed.
• Lead-in Sheets: Enter the number of Lead-in Sheets that need to be printed at the start of the

print run, or select <None> in case you don't want to use any.
• Lead-out Sheets: Enter the number of Lead-out Sheets that need to be printed at the end of the

print run, or select <None> in case you don't want to use any.
• Die Cut Layout Input Ink: Specify the ink of the input file of which its contents will be used for the

lead-in/lead-out sheet. This is typically a technical ink (for example Cutter).
• Die Cut Layout Print Ink: Specify the ink that will be used to print the lead-in/lead-out sheets. This

must be one of the inks of the selected Ink Set in the Color Management tab.

Note:  There is an exception to this rule for the HP DFE: if you print in CMY, you still use
Black.

• Comments: Use SmartNames or choose Custom to enter print job related comments. They will be
included with the file sent to the press, and become visible on the press's software panel (if your
press model supports it).

Files tab
In this tab, you define the One-Ups. The available options depend on whether this is a Duplex print or
not.

For both part in this tab, you can choose Custom to define the settings here. Or you can choose [From
JDF Ticket] to have them decided by an input JDF file.

 

 

About the Task Input Files and One-Ups

• For pre-imposed PDFs or single-grid step and repeat files, only one file is needed to be added here
as One-Up. If you are using multi-grid step and repeat, add here as many file entries as you will send
to this task.

• In the Step and Repeat tab, you can map the here defined one-ups as input files for the desired grid
of the template step and repeat.

• In the case you use VDT Files, you also need to define a Database file and optionally an Image path.
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Note:  If the amount of the task's input files is not equal to the number of files specified in this
Files tab, you will get an error.

Here are some specifics per use case:

For a One Sided Print Job
For one sided print jobs, keep the Duplex print option disabled. In the One Up settings, choose
custom.

For a Duplex Print Job

Note:  Not all digital presses support duplex printing.

To create a duplex print job, select the option Duplex print. Then define the

Backing Up mode:

• Select Tumble if you want the roll to be re-inserted into the digital press with rewinding.

• Select Turn if you want the roll to be re-inserted into the digital press without rewinding.

The One-Up Settings list allows you to Custom specify an input file for both the Front and the Back
side of the print job.

With duplex print jobs, the same Database File and Image Path is used for the same grid for both Front
and Back.

For a VDP Job
For VDP jobs, you also need to specify the source of the variable information. To do this, follow these
steps:

1. In One-Up Settings, choose Custom.
2. Click Add.
3. In the field for the database file, click Select.

In the Select Database File dialog, your Source can either be a 

• CSV File. This is used in case the job contains complex information such as names, serial
numbers or links to images. 

• Simple Database. In this case, you only use "Simple Counters". This is suited for jobs that only
require a simple sequence of numbers. Define how many records need to be generated in
the field Number of Records.

Learn more in the user documentation of your DFE.

Note:  Creating a VDP print job from a VDT file is supported for Dynamic Workflows (for version
support, check http://www.esko.com/systemrequirements).

Step & Repeat Tab

Concept

The Step & Repeat Settings can be defined
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• here, in this tab of this task. To do this, select Custom and read below how to define the settings.
Disable the option Step & Repeat if you do not want to step & repeat.

• On the DFE, as part of the settings in the selected print job ticket. To do this, use the SmartName
[From Print Job Ticket]. The task then reads that DFE ticket and shows its settings here, in read-
only mode.

• by a JDF input file, using the SmartName [From JDF Ticket].

Note:  When using the PowerLayout DeskPack plug-in to send jobs to the DFE, you have
already created your step & repeat, so that input file will here be considered as a one-up.

Defining the Type of Step & Repeat in this Ticket

When you enabled the option Step & Repeat and you selected custom in Step & Repeat Settings, you
can define Template based or Tabular layouts.

Creating a Template based Step & Repeat

If you want to step & repeat from a template, select one in the Template field.

Important:

• If you are working with multiple input files, you need to use a step & repeat template. You
cannot define a tabular step & repeat.

• Template based step & repeat is only supported when using a Print Job Ticket of the
Workflow Type 'Dynamic'.

Note:  Step & repeat templates and marks can be created in DeskPack (PowerLayout
Standalone & Dynamic Marks). Learn more on how to create these templates in the DeskPack
documentation.

If your template has multiple grids and you have selected multiple one-ups in the Files tab, the task will
automatically assign the first grid to the first one-up, etc. You can change this following these steps:
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1. Select a grid either by clicking it in the Sheet Preview or by using the arrows in the Grid parameter.
2. In the list of One-Ups (that was specified in the files tab), select the one to go with this grid. In this

way you can assign the desired number of input files to a certain grid.
3. Repeat this for each grid and one-up you want to associate.

Note:  If the number of one-ups does not match the number of grids in the template, or if the
size of a one-up does not match the size defined in the template's grid, you will see a warning
icon in the sheet preview.

The Grid Details tab will automatically be filled with the data of the selected grid from the template.

When working with duplex print jobs, you need to specify an input file in the One-Up parameter (Files
tab) for both front and back. See this example:
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Creating a Tabular Step & Repeat

This mode is available when you do not select a template. You can then specify all Grid Details in this
ticket and you can optionally specify Variable Data settings.

Learn more below in Grid Details and in Variable Data Tab on page 38.

Sheet Preview

The Sheet Preview shows a preview of the result of your grid settings. You can also select grids by
clicking on them in this preview.

Note:  When you selected a template via a SmartName, the preview will not be available.

Adding Finishing Marks and Defining Margins

Learn more below in Marks and Margins on page 40.

Indication of Grid/Template Size and Actual Repeat Area
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At the bottom of the dialog, you will see the Grid Size (if you defined a tabular step & repeat), or the
Template Size (if you used a template). This includes the margins you defined in Marks and Margins.

The Actual Repeat Area shows the area actually used by the repetition, not including the margins. The
width and length values are calculated based on the step & repeat parameters, including gaps. You
cannot edit them.

Grid Details Tab
When you have only defined one One-up file in the Files tab, this is where you can define tabular step
and repeat settings for that single one-up.
 

 

Note:  If you are using a template, this tab will automatically be filled with data from the
template (which is then non-editable).

Repeat one-up using its: Choose whether to use the dimensions of the one-up's Trim Box or Media Box
to calculate the repetition grid.

You can see the One-up Size on the right.

Clip on trim box with bleed of: Use this option to add bleed when clipping a one-up on the Trim Box.

Note:  This value should not be larger than half of the gap defined in the corresponding
direction.

Orientation: Choose how to orientate the one-up.

Available Repeat Area: Define the width  and length  of the repeat area.

• The width can be set to Substrate Width (the width of the substrate you chose in the Printing
Properties) or to a Custom value.

• The length can be set to the Maximum Repeat Length or to a Custom value.

Repetition: This defines the number of horizontal  and vertical  steps in the repetition grid. You
can choose either:

• Maximum: The server will calculate the maximum amount of repetition steps possible within the
Available Repeat Area.
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• Custom: Enter the repetition amount of your choice.

Gaps: The values you enter here (for a horizontal  and a vertical  gap) will be used as a distance
between the one-ups' borders in the repetition grid.

Note:  For seamless printing, the top and bottom margin have to be equal to half of the vertical
gap.

Variable Data Tab

Note:  This tab can only be used when you are working on a variable print job (for this you need
to have selected a Print Job Ticket of the Workflow Type 'Dynamic'.

Note:  To send variable print jobs, the HP DFE needs to be version 4.0 or higher.

Use this tab to define how to distribute your variable data over the grid of one-ups that you built in the
Grid details tab, or over the one-ups repeated according to the Template that you chose.

Start: Choose where to start printing your variable data (where to print the first record):

 top left,  top right,  bottom left,  bottom right.

The preview on the right shows a black dot representing the position of the first record.

For example, this distribution starts on the top left:
 

 

while this distribution below starts on the top right:
 

 

Choose also if the flow of variable data should run horizontally  or vertically .

The preview on the right reflects your choice.
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Horizontal flow:
 

 

Vertical flow:
 

 

Note:  The Printing direction marked with an arrow shows the direction that the paper flows
through the press.

Note:  When you selected a button via a SmartName, the preview will not be correct.

Fill over: Choose if you want to distribute the variable data over the Complete Job or over Blocks.

If you choose Blocks, the variable data flow will run over Blocks of a certain size, then run over the next
Block when the previous one is complete.

You can see an example of Blocks in the preview.
 

 

Block Size: You can define the size in Grid Rows, Sheets, Feet or Meters.

If you have chosen to Fill over the Complete Job, then the Block Size will be 1.00 Job by default.

You can set it to another unit if you still want to print in Blocks, but without having the variable data
flow respect the Block. This is useful if you want to add gaps (see below).
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Add gap between blocks: This adds white space in between the Blocks. It is available when you have
chosen to Fill over Blocks, or to fill over the Complete Job but still have Blocks (as explained above).

Gap size: This is available when you have selected Add gap between blocks. Define the gap size in Grid
Rows, Sheets, Feet or Meters.

Marks and Margins
Click on Marks and Margins to add marks and margins to your output.

Note:  You can also set marks and margins when you are not using step and repeat in your print
job (when the Step and Repeat option at the top of the dialog is deselected).

Marks

Choose if you want to add Finishing Marks to your print job. Finishing marks are used to align the
substrate for cutting. Select a set from the list or use [From Print Job] or any other SmartName.

The list offers the marks that you made in 'Dynamic Marks' and, in case of an HP DFE, also the default
marks 1 x LabelRow, 1 x Sheet or 2 x LabelRow.

Note:  These marks are all visible when Step & Repeat is active, or from within PowerLayout.
When Step & Repeat is inactive, only 1 x Sheet is shown.

Note:  If you are using a Step and Repeat template from the DFE, you can not add finishing
marks here. The marks from the template will be applied.

Note:  Second pass marks (also called "reinsertion marks") can not be controlled from
Automation Engine. Those can only be set on board the DFE ticket

Margins
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You can define each margin (1, 2, 3 and 4) using the following:

• Gap (Length or Width): The size of a gap between one-ups.

• Gap (Length or Width) / 2: Half the size of a gap between one-ups. This is typically used for top and
bottom margins, as the bottom margin of one sheet plus the top margin of the next sheet will be
equal to one gap.

• Custom: a custom number (formulas are not allowed).

Note:  If you selected a finishing mark which size you defined in the DFE's configuration tool,
the corresponding margin will show up as Defined by Mark.

This means that the margin is automatically large enough to provide space for this finishing
mark. For example, if you, on a HP DFE, selected the default mark 1 x LabelRow, which is set
in the DFE configuration tool to need 8 mm of right margin, the right margin (4) will be set to
Defined by Mark and be 8 mm wide.

Transformation Tab
• Vertical Scale: Use this to scale the print job vertically (in the length).

• Horizontal Scale: Use this to scale the print job horizontally (in the width).

• Rotation: Choose the rotation of the print job (None, 90˚ CW, 180˚ or 90˚ CCW).

Note:  Rotation is disabled when Step and Repeat is enabled.

• Mirror: Choose whether or not to mirror the contents of the print job.

Color Management Tab
• Ink Set: Choose the set of process inks that will be generated by the RIP. The list depends on the

press model.

• Use: Define if you want to use color management when RIP'ing the print job (to convert the file
separations to the ink set used by the press), and what kind of color management. Choose <None> if
you don't want to use any color management settings for this conversion.
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• When you do want use color management here, select a Color Strategy from the list (or use a
SmartName).

3.5.  Submit to Esko DFE

Note:  This task is only used as part of a pre-defined workflow used in the browser client of
Automation Engine (the QuickStart deployment).

Concept
This task submits a print-ready PDF or a JDF referencing print-ready PDF files to an Esko DFE.

An Esko DFE here means any DFE developed by Esko, so also those that were re-branded by 3rd party
vendors and named "Powered by Esko".

Restriction:  The HP flavor of the Esko DFE requires that the file has the minimum repeat
length for a typical HP press (HP6x00), which is 470 mm. When you submit a PDF file that is
smaller than 470 mm to this type of DFE, this Submit task will still process the file but, on the
DFE, the HP print job is not created.

Task Options

• Device: Select a device from the list of Esko DFE devices that you added in the Device view.

• Due Date: Choose a time when this job should be printed.

Note:  A due date specified by a SmartName must resolve to a valid ISO 8601 string, i.e. the
format yyyy-mm-ddThh:mm:ss . For example 2017-03-10T10:00:00 .

• Copies: Specify the number of frames to print.

• Print Job Ticket: Click on  to select one from the list of tickets on the DFE of the selected device.

• Substrate: Click on  to select a substrate from the list of substrates specified on that DFE.

• Color Strategy: Click on  to select a color strategy from the list of strategies specified on that
DFE.

When the specified Print Job Ticket is of the type "Classic", only "Classic" Color Strategies are
allowed. When the specified Print Job Ticket is of type "Dynamic", all Color Strategies are allowed.

Note:  The priority of the print job in the Esko DFE is inherited from the priority of this task.

3.6.  Submit to HP SmartStream Production Pro Print Server

Concept

HP's Digital Front End "Production Pro" is used to drive HP Indigo presses. This task submits a JDF
file to the HP Production Pro. The JDF includes references to the print-ready PDF file(s) and various
options on how this job should be printed..
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Typically, Automation Engine creates a step & repeat PDF including marks and submits that file to the
DFE in its original color space (process + spot colors).

Task Options

• Tab General

• Device: Select a device from the list of configured HP Production Pro devices that you added in
the Device view.

• Due Date: Choose a time when this job should be printed.

Note:  A due date specified by a SmartName must resolve to a valid ISO 8601 string, i.e.
the format yyyy-mm-ddThh:mm:ss . For example 2017-03-10T10:00:00 .

• Internet Input Method: Click on  to select the 'Internet Input method' from the list of available
methods that were specified on the HP Production Pro. (On the HP Production Pro, this term is
used for a 'ticket').

• Print Job Name: In stead of the default name based on the input file, you can here specify a
different name for how this print job will appear on the HP Production Pro.

• Comments: You can here for example add instructions for the press operator. They will appear
on the Production Pro (Job >  Information >  Comments) and also on the HP press interface.

• Automatic Export: Select whether, on the HP Production Pro, the submitted job should
(afterwards) automatically be exported (a form of archiving).

• Use value from internet input method: as defined above (default value)

• Yes (SmartName resolving to 'true')

• No (SmartName resolving to 'false').

Note:  This requires the HP Production Pro to be on v8.2 or higher.

• Tab Production

• Copies: Specify how many copies of the input file should be printed.

Note:  When this task is started from the browser client workspace 'Roll-fed Labels',
then this is typically a Step & Repeat PDF, there referred to as a 'frame' or 'sheet'.

Attention:  When all the frames in the job are identical (so a static job, also without LILO
sheets), then this number of copies will reflect the number of frames to be printed. This
way the HP press operator can still easily overrule the run length.

• Substrate: Click on  to select a substrate from the list of substrates specified on that HP
Production Pro. Alternatively, leave this field to the default 'Use value from internet input
method' or use a SmartName.

• Color Strategy: Click on  to select a color strategy from the list of strategies specified on that
HP Production Pro. Alternatively, leave this field to the default 'Use value from internet input
method' or use a SmartName.
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• Lead-in Sheets: Enter the number of Lead-in Sheets that need to be printed at the start of the
print run, or select <None> in case you don't want to use any.

• Lead-out Sheets: Enter the number of Lead-out Sheets that need to be printed at the end of
the print run, or select <None> in case you don't want to use any.

• Die Cut Layout Input Ink: Specify the ink of the input file of which its contents will be used for
the lead-in/lead-out sheet. This is typically a technical ink (for example Cutter).

• Die Cut Layout Output Ink: Specify the ink that will be used to print the lead-in/lead-out sheets.
This must be one of the inks of the selected PDF file.

Note:  There is an exception to this rule for the HP DFE: If you print in CMY, you still use
Black.

• Tab Transformation

• Rotation: Choose the rotation of the print job from the list.

• Mirror: Choose whether or not to mirror the contents of the print job.
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4.  Using Shared Resources between AE and
the DFE

By default, Automation Engine and the Digital Front End are each installed with their own resources
(for color management, dot gain curves, step & repeat templates and marks).

However, when working with Automation Engine and the Digital Front End together, you need to make
sure they are using the same resources.

This is very important, as if you set some parameters in Automation Engine using resources that are
not available to the DFE, you will have trouble sending your job to print at the DFE side.

Note:

You should only use one Color Pilot application for color management, that works with the
same color database that both Automation Engine and the Digital Front End use.

This should be the Color Pilot application that came with your Digital Front End software.

Before You Start
Before you start merging and redirecting resources, make sure that:

• Automation Engine, your Digital Front End server and Color Pilot are located in the same Local Area
Network,

• your DFE server's BGSYSTEM user has read and write access to the following shares on your
Automation Engine server:

bg_data_cms_v010
bg_data_dgc_v010
bg_data_custom_v010
bg_data_marks_v010

Cases
• If this is your first installation of both applications, you can just redirect your Digital Front End to

look at Automation Engine's resources.

See Using Shared Resources for Newly Installed Applications on page 45.

• If you have been working with Automation Engine and your Digital Front End for a while, you
probably have custom data in both sets of resources.

In this case you also need to merge your resources. See Using Shared Resources for Existing
Applications on page 46.

4.1.  Using Shared Resources for Newly Installed Applications

If you have just installed both Automation Engine and your Digital Front End software for the first time,
their resources only contain default data.
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In this case, you just need to make sure that your Digital Front End and Color Pilot software use
Automation Engine's resources.

1. Redirect your DFE server to use Automation Engine's resources instead of its own.
a) Open your DFE server's Configuration Tool by going to Start > All Programs > Esko > [DFE Server

Type and Version] > [DFE Server Type] DFE Configuration.
b) At the bottom of the Data tab, under Resources Search Path, click the Configure... link.
c) In the Resource Server location changed pop-up, select On another computer, and enter the

name of your Automation Engine server.
d) Click OK, and OK again in the Configuration Tool.

This makes sure the DFE uses Automation Engine's color database, curves database, Step & Repeat
templates database and marks database.

2. Check that your Color Pilot application uses the color database set in your DFE server (which is the
Automation Engine color database).
a) Go to Edit > Preferences... and click the Servers tab.
b) Under Esko Server, check or fill in the connection details for your DFE server (Server Name,

User Name and Password).
c) Click the Check Connection button. You should see Status: Connected (with a green dot).
d) Click the Database tab and select Obtain from Esko server. The name of your DFE server should

be visible.
e) Click OK.
f) If you get prompted to restart your Color Pilot, click Restart Now to confirm.

4.2.  Using Shared Resources for Existing Applications

If you have been working with Automation Engine and your Digital Front End for a while, you probably
have custom data in both sets of resources.

In this case you also need to:

• copy the curves, Step & Repeat and marks data from your DFE server to Automation Engine,
• merge your color databases, by exporting the data from your DFE's color database into your

Automation Engine's color database.

Note:  To minimize disruptions, you should do this when your DFE server and your Automation
Engine server are not in use.

1. Copy your DFE's curves data to Automation Engine.

The curves data is typically located in C:\Esko\bg_data_dgc_v010 on your DFE server.

Merge it into your Automation Engine server's bg_data_dgc_v010 share (\\[AE Server
Name]\bg_data_dgc_v010).

2. Copy your DFE's Step & Repeat data to Automation Engine.

Step & Repeat templates are typically located in C:\Esko\bg_data_custom_v010 on your DFE
server.

Merge this folder into \\[AE Server Name]\bg_data_custom_v010.
3. Copy your DFE's marks data to Automation Engine.
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The marks data is typically located in C:\Esko\bg_data_marks_v010 on your DFE server.

Merge this folder into \\[AE Server Name]\bg_data_marks_v010.

Note:  Some marks data is also present in the bg_data_custom_v010 folder, that was
merged in the previous step.

4. Open your Color Pilot application to merge the color databases.
5. Check that your Color Pilot uses the color database of your DFE server.

a) Go to Edit > Preferences... and click the Servers tab.
b) Under Esko Server, check or fill in the connection details for your DFE server (Server Name,

User Name and Password).
c) Click the Check Connection button. You should see Status: Connected (with a green dot).
d) Click the Database tab and select Obtain from Esko server. The name of your DFE server should

be visible.
e) Click OK.
f) If you get prompted to restart your Color Pilot, click Restart Now to confirm.

6. Still in Color Pilot, export the data from your DFE server's color database.
a) Go to File > Export Library...
b) In the Export Library dialog, check that Export as one single archive is selected.
c) Browse to your desired location, change the name of the FilePacker (.fp) archive that will be

exported if you want, and click Export.
d) Depending on the amount of data, you may get a warning that the export can take a long time.

Click Yes.
7. Redirect your DFE server to use Automation Engine's color database instead of its own.

a) Open your DFE server's Configuration Tool by going to Start > All Programs > Esko > [DFE Server
Type and Version] > [DFE Server Type] DFE Configuration.

b) At the bottom of the Data tab, under Resources Search Path, click the Configure... link.
c) In the Resource Server location changed pop-up, select On another computer, and enter the

name of your Automation Engine server.
d) Click OK, and OK again in the Configuration Tool.

8. Restart Color Pilot.
Since Color Pilot takes the location of the color database from the DFE server, and the DFE server
takes it from the Automation Engine server, Color Pilot is now using Automation Engine's color
database.

9. In Color Pilot, import the DFE color database archive into the Automation Engine color database.
a) Go to File > Import...
b) Browse to the FilePacker archive of the DFE color database that you exported earlier and click

Open.
c) In the Import dialog, click Import All.

Note:

If some items with custom data are present in both color databases (like for example the
designer ink book), they will be merged.

Merging adds any data from the archive that wasn't present in the Automation Engine
database, but does not replace any data.
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d) Click Close when the import is done.

48


	1. Intro
	2. Devices (Digital Presses)
	3. Tasks related to Digital Printing
	3.1. Convert Colors for Digital Printing (Classic)
	3.2. Preflight Color for Digital Printing (Ink based)
	3.2.1. Task Parameters
	3.2.2. Preflighting a File's Colors
	Color Preflight Results

	3.2.3. Preflight Color for Production
	Example Workflow

	3.2.4. Preflight Color for Cost Estimation
	Example Workflow
	Workflow with MIS Integration


	3.2.5. Pre-configured Preflight Color Workflow
	Requirements
	Preparation
	Workflow Overview
	Main Workflow
	Multi-page Workflow

	Using the Workflow(s)
	Workflow Reports
	PDF Report
	XML Report



	3.3. Preflight Color for Digital Printing (Content based)
	3.4. Print on Digital Press
	3.4.1. Supported File Types
	3.4.2. Using the Print on Digital Press Ticket in a Workflow
	3.4.3. Print on Digital Press Task Settings
	General Tab
	Files tab
	Step & Repeat Tab
	Grid Details Tab
	Variable Data Tab
	Marks and Margins

	Transformation Tab
	Color Management Tab


	3.5. Submit to Esko DFE
	3.6. Submit to HP SmartStream Production Pro Print Server

	4. Using Shared Resources between AE and the DFE
	4.1. Using Shared Resources for Newly Installed Applications
	4.2. Using Shared Resources for Existing Applications


